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About Network Rendering

KeyShot Network Rendering allows you to connect multiple computer systems in your office network and utilize the available hardware to reduce rendering times
significantly. In fact, the correlation between render time and number of cores in your network is approximately linear and inversely proportional.  In other words, by
doubling the number of cores you potentially cut your render time in half.* In addition, rendering over the network is convenient. You may continue working in KeyShot
or any other application without slowing down your system while the designated rendering stations process your render “jobs”.

The KeyShot Network Rendering software is compatible with Mac and PC systems.

The more cores you have, the faster your images and animations will render.**

* Please note that this is an approximation under optimal conditions.  Render times are subject to hardware specs, core count differences between slaves, scene
complexity, time scale, multi-tasking, and network traffic.

** Please note that Luxion does not sell or rent cores.  All computer hardware (i.e. processor cores) is provided by the customer.
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How it works

KeyShot Network Rendering consists of three roles:  Clients, Master, and Slaves.
The figure shown below illustrates the simplest interaction between the roles, where each computer only has one
role.

A computer configured as a master and/or slave can also function as a client. In the master’s case, KeyShot (the
client application) communicates internally with the master service which runs in the background.

It is important to note that there should only be one master on the network!

Client Master Slave

Sends job requests to master
(via KeyShot)
Receives completed jobs from
master
Saves final output to specified
location
Can modify certain
configurations of the master,
like users

Receives job requests from
clients and places them in a
queue
Divides each job into
computation tasks
Assigns tasks to each slave
Compiles all rendered output
into a final image, video,
KeyShotXR, or configuration
Sends completed jobs back
to clients

Receives rendering tasks
from master that it
computes
Sends completed task
results back to master
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Best Practices

Network Rendering Process
The Master receives a job from the Client. It splits the job into tasks that are computed by the slaves. When a
slave finishes a task, the rendered pixels are returned to the master. When all tasks are completed, the master
assembles them into the finished image, video, KeyShotXR, or configuration. For still images, the tasks consist of
regions of the images, and for animations, KeyShotXRs, and configurations, the tasks are whole frames.

Total job processing time consists of transfer, rendering, and assembling time. The transfer time depends on
network connection and file size, rendering time depends on slave capacity and rendering settings (render passes
and layers), and assembling time depends on the master capacity and output size (image resolution and number
of frames).

Network Configuration
The performance of KeyShot Network Rendering is subject to network connection and configuration. To obtain the
best results we recommend:

To use the same processor type for all computers
To have an equal amount of cores per slave
The tasks assigned to each slave are generally of equal size, so if one slave is less powerful than the others
it may delay the assembling of the job
To maximize the core count but minimize the slave count
This will decrease the time spent on transferring the scene to all slaves. Also, if the number of slaves
exceeds the number of tasks of the job, the excess slaves will be left idle if no other jobs are in the job
queue
1 Gbit network interfaces or faster.

CPU Specification

The performance of KeyShot Network Rendering is dependent on your CPU specification. To obtain the best
results, select high performance processors, e.g. Intel Xeon or AMD Threadripper. See our Benchmark section in
the KeyShot forum for inspiration.

Jobs suited for Network Rendering
As mentioned above, the total processing time of a job in network rendering is dependent on effective transfer,
rendering, and assembling time. This is the reason why the following kinds of jobs are best suited for network
rendering:

Complex scenes
KeyShotXRs
Configurations
Still images where local rendering times exceed 1 hour
Animations, KeyShotXRs, and Configurations where rendering time of each frame exceeds 10
minutes
If the rendering time pr. frame is less than that, the transfer time in Network Rendering could make local
rendering more efficient.

Preparing jobs for Network Rendering
If you want the fastest processing time for your Network Rendering jobs, consider the following:

File Size - The file size affects the file transfer time. To minimize file transfer time, keep the BIP/KSP file
size low. To minimize the size you can delete all unused items in the scene, such as unused environments,
textures etc.
Rendering Settings - Everything you choose to include in the rendering counts. Render passes will
increase the amount of data per pixel, and render layers will increase the amount of pixels being
transferred.

Linearity
In an ideal render farm, doubling the core count cuts the render time in half. To obtain maximum linearity between
core count and render time:

Added computers must use the same processor (or better)
Added computers must have the same core count (or higher).
Current render times must be greater than 1 hour.
Number of render tasks must be greater than the current computer count.*

On this page

Network Rendering Process
Network Configuration

CPU Specification
Jobs suited for Network
Rendering
Preparing jobs for Network
Rendering
Linearity

Note:
If you are rendering a scene with caustics, global illumination and/or Interior mode, we recommend
updating to KeyShot Network Rendering 8.2.98 or later. Learn more



https://www.keyshot.com/forum/index.php?board=36.0
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415662466/Known+Issues
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*Computer count should not be confused with core count. If the number of render tasks in a job is less than or
equal to the current computer count, then adding more computers will not have any effect on the render speed for
that job.
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Release Notes

The following page contains an overview of updates for KeyShot 8 Network Rendering.

8.2
 (8.2.99) If either, Causicts, Global illumination or Interior Mode are enabled, the master will break up still
images into larger horizontal bands instead of square regions.

Render Jobs will be split up into noticeably fewer tasks.
This will lead to a decrease in performance for setups in which the number of slave nodes is higher
than the number of tasks per job.

(8.2.99) Regions are rendered with a 10 px overlap  that will be interpolated to prevent banding if either,
Causicts, Global illumination and/or Interior Mode is used.
Remove NR launch daemons in macOS installation pre step.
Remove privileged requirement for NR slaves and master.
Remove /tmp/KSNR8_SLAVE_SERVER in post-install step for NR.
Create setting in NR for toggling whether it should use system proxy or not (only via the settings file
directly).
Ask to complete/abort active tasks when pausing job via Monitor.
Prompt user on task completion when worker is set to pause.
Keep sending Progress updates for inactive slaves.
Added confirmation message on Successful setting import in the KSNR configurator.
Made "Setup" part of Preparing Slave Status.
Scattering media scene causes windows NR slave to crash.
Network rendering Monitor shuts down on ubuntu 18 when logging in.
NR slaves will got stuck at "sending results" state when rendering a job with more than 5 files.
"Could not uninstall Service"" error on ubuntu 18.
Running watchdogs and slave tray as logged-in user installing them.
Multiple "User Account control" pop ups during uninstall of KSNR on windows.
The Slave Tray shut down if the Slave is set to Paused.
Linux slaves did not handle Unicode characters.
Terminating watchdogs before killing processes and uninstall after.
Running Configurator button on Linux Network Rendering did not have permission to run.
The master service now takes Cores that are checked out by an other master into account (FlexLM).
Fixed white square in slave schedule manager.
Network monitor now cleans up correctly when Logging out.
No longer failing slaves when pausing via monitor or slave tray.
Fix for issue when submitting and deleting jobs quickly caused master to not process jobs.
Fix for jobs that got stuck on "pausing" state when currently rendering slave was paused.
Fix for issue in which "used cores" was not order properly.

8.1
Enable FlexLM for the NR master. 

Added Floating License configuration to the NR configurator.
Include OpenSSL DLLs with NR to support downloading updates.
Support removing local job that is archiving or sending.
Safe config import via import pane and silent install.
Ensure inactive slaves are removed from queue when updating.
Exclude non-portable settings values when saving as INI.
Stop NR Master when deactivating license.
Fixed so NR Monitor can handle many downloads.
Stop/start local server on fast user switch.
Update NR manual link to use major version.
Respect the choice if the user selects 'No' in the 'Are you sure?' uninstall message box (Windows).
Fixed Configurator crashes by separation of logic and cleanup.
Fixed sorting logic in NR Monitor, especially so increase/decrease priority works with non-default sorting.

Move up/down uses prioritized jobs rather than visual ordering.
Fixed versions in NR Mac Apps .plist files to be dynamic.
Added and updated translations.
File transmission cancelling works on both sides and will remote-cancel if necessary.

Master tries to cancel both master and job manager file transmission on cancelling session.
NR Slave Tray writes to log file in user space to make potential errors visible.
Fixed NR service start bug.
Don't show meta-data file as job download result in NR Monitor (.xmp and .meta).
Do not clear the coreUsage when the license server connection is lost, because the slaves will keep the
connection.
Show kind for unhandled packet types.

Relases

8.2
8.1
8.0
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Expose file transmission session ID when sending files.
General fixes and improvements.

8.0
Button in slave status window to "Request all current logs".

Right-click > "Request current log file" per slave.
Ability to deactivate and reactivate license on Master via Configurator.
License info is remembered and auto-filled if a new license is required.
Only active cores count towards license.
Master writes tiles to resource folder instead of system temp folder so that it can be configured to be
elsewhere if needed (along with everything in the resource folder).
Fixed rare cases where slaves were not put back to the ready queue for processing new tasks.
Fixed inter-process locking issues that would freeze the Master for a duration of time.
Master assigns cores to slaves at job start time, not at slave login time, which means cores are dynamically
redistributed.
In Monitor, the "Hide" action in "File" menu is now dependent on the visibility state.
Fixed issue with removing a paused task.
Set "failed" state for slave if it fails at least 3 times in a row. Afterwards it must be manually reactivated by
an admin in the slave status window in the Monitor.
Proper destruction phase for Master and Slave when process is shutting down.
Reinstate "Move Up" context menu action in Monitor for Jobs.
When user system is not in use, consider all jobs as anonymous but all users get admin privileges.

Don't allow any user changes via Monitor if user system is disabled.
Pausing a job with active jobs will make the job state be "Pausing" until every related slave is finished, then
it switches to "Paused".
(Mac) Fixed temp folder used when Master a/o Slave were run via Configurator via installer, which yielded
I/O errors.
If a Slave fails to receive or send data, the master will fail its task so another can try it. This also means that
the Master will not wait forever on the task.
Monitor uses download folder instead of desktop folder for received logs.
Errors are shown in Monitor if any requested logs could not be retrieved and which slaves were the culprits.
In such cases, the Master sends all logs it did receive in time.
Show correct output file in Monitor for still images, which didn't always work when having render passes and
layers enabled.
Gracefully abort any file transmission sessions if connection is lost, and send next enqueued data. Fixes an
issue where the Master, for instance, would stop sending data permanently in rare cases.
Split regions with 128 px as the smallest size instead of 32 px to yield less job tasks that generally speeds
up overall rendering and processing time.
(Mac) Removed outdated compatibility with KeyShot 3.
Slaves only send rendering progress in controlled network packet bursts to not overwhelm the network.
Monitor shows a message if an outdated Slave tries to connect to the Master.
Remember time when job finished in order to calculate time spent correctly.
(RESTful API) Fixed certain endpoints described in / JSON to not have / at the end.
Master doesn't stream frames to Monitor if in FIFO download order mode.
General fixes and improvements.
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Known Issues

Interior Mode may display tiling between regions

When rendering using Interior Mode there may be visible "seams" between regions. When rendering animations
using Interior Mode there may be a visible difference in brightness between frames. Increasing the resolution of
the image may help remedy this issue. But there will be certain lighting scenarios where tiling may still be visible
regardless of size and the number of samples. In this case you may want to consider rendering the scene locally
on your machine.

Update
With the release of 8.2.98 this is no longer an issue.

The the way KeyShot Network rendering splits and handles jobs has been optimized. This means that you
will no longer experience banding, on scenes using Global illumination, Caustics or Interior Mode (In
Interior Mode you will also experience faster rendering times in general).

Notice that the new method will result in lower task counts for each job.

Please update to 8.2.98 or newer.


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Getting Started

Get KeyShot Network Rendering
You can download the latest version of KeyShot Network Rendering here.

License

The master requires a valid Network Rendering license, but computers functioning as slaves and/or clients do not.
Clients that send jobs to Network Rendering will need a valid KeyShot license. Learn more about setting up the
License on the Master.

Install
Network Rendering must be installed on all the computers you want to use either as Master, Slaves, or Clients.

When you install Network Rendering on your computer you effectively install the following applications:  

1. KeyShot Network Configurator: Here you set up the roles of the current computer.
2. Master service*: Handles all jobs and assigns tasks to the available slaves.
3. Slave service*: Renders the tasks (regions or frames) assigned by the master.
4. KeyShot Network Monitor: Displays the job and slave status, and facilitates sending jobs from KeyShot to

KeyShot Network Rendering.
5. KeyShot Network Slave Tray: Enables users to visually control how many cores a local slave is allowed to

use.

*Although the slave and master services are installed on your computer, you still need to “turn them on” inside the
KeyShot Network Configurator application. When enabled, the master and slave services run in the background.

 KeyShot Network Configurator

The first time you launch Network Configurator upon installation you will meet the Configuration Wizard. This will
guide you through the configuration of your machine as a Master and/or as a Slave - or simply as a Client by
selecting Monitor only.

You can always edit the setup at a later stage, just open the Network Configurator. Now you can re-launch the
wizard or make your edits directly.

The following pages in this section will describe the configuration of Master, slaves and clients.

 KeyShot Network Monitor

After configuring your services, KeyShot Network Monitor enables you to connect your client computers to the
master. It gives you an overview of all jobs in a queue, and gives you access to all the Monitor features.

On this page:

Get KeyShot Network Rendering
License

Install

 KeyShot Network
Configurator

 KeyShot Network
Monitor

 KeyShot Network
Slave Tray

In this section:

Installing KeyShot Network
Rendering
Master Configuration
Slave Configuration
Master and Slave Configuration
Client Configuration
Render Over The Network

Note
Please note that it is recommended to only have one computer in your network configured as the master,
especially if using master auto-detection.



https://www.keyshot.com/resources/downloads/
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418578670/License
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/416088413/Network+Monitor
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/836272133/Installing+KeyShot+Network+Rendering
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418250898/Master+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418250927/Slave+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596834/Master+and+Slave+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418283759/Client+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415891808/Render+Over+The+Network
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 KeyShot Network Slave Tray

If your computer is configured as a slave you will see the KeyShot Network Slave tray widget on your task bar (PC)
or menu bar (Mac) - but only if not disabled in the Configurator. Its function is to set the number of cores that the
slave service utilizes for rendering jobs.

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596880/How+To+Change+The+Number+Of+Cores
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Installing KeyShot Network Rendering

Windows and MAC
1. Install. Download and Install KeyShot Network Rendering. Follow the prompts and click Finish.
2. Set up. Upon installation KeyShot Network Configurator wizard is automatically launched.

See following pages for step by step explanations of the wizard:
Slave Configuration
Master Configuration
Master and Slave Configuration
Client Configuration

On this page

Windows and MAC
Linux

Linux
KeyShot Network Rendering has been verified on:

Ubuntu 16.04 and Ubuntu 18
Other distribution with glibc version 2.23 or later
Linux kernel version 2.6.32 or later

You can either install KeyShot Network Rendering via the Terminal or via the Linux UI. For setup via the Terminal
follow the steps described in the readme file, which is included in the download package. Otherwise, follow these
steps:

1. Download
Download the install package and save to a local drive, e.g. the Documents folder.

2. Unpack
Launch the terminal and unzip the .zip file

3. Install
Run setup.sh

4. Set up. Double click Run Configurator and set up the services. See the following pages for step by step
explanations of the settings.

Slave Options
Master Options

luxion@ubuntu:~$ cd /home/luxion/Documents/

luxion@ubuntu:~/Documents$ unzip keyshot_network_rendering_linux64_8.2.xx.

1

2 luxion@ubuntu:~$ cd /home/luxion/Documents/keyshot_network_8/

luxion@ubuntu:~/Documents/keyshot_network_8$ sudo -E ./setup.sh

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418250927/Slave+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418250898/Master+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596834/Master+and+Slave+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418283759/Client+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/629342425/Slave+Options
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418283788/Master+Options
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Silent Installation

You or your IT department may wish to do a KeyShot Network Rendering silent install, i.e., unattended installation.
This is especially useful for unattended deployment onto servers. Please note that service setup is still required. To
set up your master or slave services, click here.

Windows
The following arguments are supported:

/S - Silent installation.

/D=<path> - Set the program files destination. This must be placed at the end of the command line inside
quotations.
/config=<path> - Import settings from file.

/license=<path> - Install license from file. If a license exists it will be overwritten.

/resources=<path> - Sets resource path and copies existing license, config, and database, if present.

Added in 8.2:

/master - Enable master service.

/slave - Enable slave service.

/mh=<host> - Sets master host the slave will connect to (also enables slave service).

/mp=<port> - Sets master port the slave will connect to.

Example of silent installation that will enable a slave and have it connect to "10.0.0.50" with default port:

Unattended uninstall:

macOS
Use the following approach to silently install KeyShot Network Rendering on macOS:

Added in 8.2:

In order to pass options to the installer, create the file "/tmp/ksnr8-silent-install.sh"

The file should fulfill the following conditions:

1. It must be owned by the user running the silent install
2. It must not be writable by group
3. It must not be writable by other

The preferred file permissions are -rw-r--r--.

In the *.sh file the following syntax is used :

For example, to enable a slave service that connects to a master at IP Address "10.0.0.50" include the following
line in your *.sh file:

The following options are supported:

On this page

Windows
macOS

keyshot_network_rendering_win64_8.x.x.exe /S /mh=10.0.0.50

C:\Program Files\KeyShot8 Network Rendering\uninst.exe /S

sudo installer -pkg keyshot_network_rendering_mac64_8.x.x.pkg -target /

export option=value

export LUX_NR_MASTER_HOST=10.0.0.50

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727884/Getting+Started
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LUX_NR_RES_DIR=<dir> - Sets resource path and copies existing license, config, and database, if
present.
LUX_NR_CONF_PATH=<path> - Import settings from file.

LUX_NR_LIC_PATH=<path> - Install license from file. If a license exists it will be overwritten.

LUX_NR_MASTER=1 - Enable master service.*

LUX_NR_SLAVE=1 - Enable slave service.*

LUX_NR_MASTER_HOST=<host> - Sets master host the slave will connect to (also enables slave service).

LUX_NR_MASTER_PORT=<port> - Sets master port the slave will connect to.

*To disable Master/Slave leave this option out (e.g. LUX_NR_MASTER=0 will not disable the master).
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Master Configuration

Your network master is in charge of several things - The master service queues jobs, holds your license file, and
archives all renderings.

In this section, you’ll set up your master service. If you wish to configure this computer as a master and as a slave,
please click here. 

Our licensing team will provide you with your activation serial code and the appropriate software links. You may
reach our licensing team at license@luxion.com. If you have an existing master service running and wish to make
changes, then click here.

On this page

1. Install
2. Select Mode
3.  Select License Type
4. Master Network Settings
5. Master Security Settings
6. Start Master Service
7. You’re done!

Master Configuration
Instructions

1. Install

Download and Install KeyShot Network
Rendering. Follow the prompts and click
Finish.

2. Select Mode

Upon installation KeyShot Network
Configurator wizard is automatically
launched. Select Master mode and click Next
(PC) or Continue (Mac).

3.  Select License Type

Select if you want to install a license file or
use a floating license by connecting to a
License Server.

3a. License file

If you have a license key, click
Request license and fill out the form.
Your network license should activate
automatically. Otherwise, click Save
license request, save the text file and
email it to license@luxion.com for
manual activation.
If you already have a license file (.lic),
click Select file, Browse to your license
file and click Open to select it.

3b. Floating License
Enter the hostname or IP address of your
license server. If the server uses another
FlexLM port than the standard (27000) you
need to specify the port number, followed by
the “@” sign and the server’s hostname/IP
(e.g. 27000@KeyShotServer.local). Click
Connect.

3c. Once the license file is recognized, the
license text shows you how many cores the
slaves (combined) can use for Network
Rendering and when the license will expire.
Click click Next (PC) or Continue (Mac).

Learn more about Network Rendering
License.

4. Master Network Settings

Choose if you want to auto-detect
clients and slaves. When auto-detect is
enabled slaves/clients on the network
will automatically connect to the

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596834/Master+and+Slave+Configuration
mailto:license@luxion.com
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418283788/Master+Options
mailto:license@luxion.com
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418578670/License
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master, otherwise you will need to
enter the master's IP and port
information in their respective
connection settings.
Select the ports for the master/client
connection and master/slave
connection. Leave the default values if
you are not sure.

Click Next (PC) or Continue (Mac).

5. Master Security Settings

If you want to be able to control who can
submit, delete, and download jobs etc. you
can enable User System. When enabled, add
the username and password for the main
administrator, i.e. the owner or facilitator.
Users are added via the KeyShot Network
Monitor.

Allowing Anonymous users will let anyone on
the network submit jobs to Network
Rendering.

Click Finish (PC) or Done (Mac). Then, click
OK.

Learn more about User System & Security.

6. Start Master Service

When you have been through the wizard the
Master is ready to go. All you need to do is
click install and start on the Master in the
Service Status section of the Network
Configurator.

7. You’re done!

Click Close to close the configurator.

If you want to learn about setting up the master in the Network Configurator, go to the Master Options section.

Note:
Please note that only one computer in your network should be configured as the master, if you need to
have multiple Masters click here.



https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727927/Users
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727937
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418283788/Master+Options
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/657915994/Multiple+Masters
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Slave Configuration

With your master configuration up and running, you may now configure your dedicated rendering stations as
network slaves. The slave service utilizes your computer’s processing power and does the actual rendering. The
instructions below will walk you through the slave service configuration. If you wish to enable the slave service on
your master, click here.

On this page

1. Install
2. Select Mode
3. Slave Network Settings
4. Start Slave Service
5. You’re done!

Slave Configuration Instructions

1. Install

Download and Install KeyShot Network
Rendering - download instructions can be
found in the mail you received from our
licensing team upon purchase. Follow the
prompts and click Finish.

2. Select Mode

The configuration wizard appears. Select
Slave mode and click click Next (PC)
or Continue (Mac).

3. Slave Network Settings

Hostname & Port - Enter the
connection settings so they match
what was entered on the master.
Leave the Master host name empty if
the master has auto-detection enabled.
Process Priority -  This will set the
priority of the slave service in the
computer. This is relevant if you are
also running other applications on the
computer, in which case a low priority
will let the other applications use what
they need of the available CPU
resources first.
Allowed Cores - Here you can set the
default number of cores that are made
available for Network Rendering. If you
need to limit it temporarily, you can do
it via the Slave Tray - see how.

Click Finish (PC) or Done (Mac).

4. Start Slave Service

When you have been through the wizard the
Slave is ready to go. All you need to do is
click install and start on the Slave in the
Service Status section of the Network
Configurator.

5. You’re done!

Click Close to close the configurator.

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418250898/Master+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596834/Master+and+Slave+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596880/How+To+Change+The+Number+Of+Cores
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If you want to learn about setting up the slaves in the Network Configurator, go to the Slave Options section.

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/629342425/Slave+Options
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Master and Slave Configuration

In this section, you’ll set up your master and slave service on the same computer. 

The master is in charge of a few things - queuing jobs, holding your license file, and archiving all renderings. The
slave service utilizes your computer’s processing power and does the actual rendering. 

Our licensing team will provide you with your activation serial code and the appropriate software links. You may
reach our licensing team at license@luxion.com. If you have an existing master service running and wish to add
the slave service, click here.

On this page

1. Install
2. Select Mode
3.  Select License Type
4. Master Network Settings
5. Master Security Settings
6. Slave Network Settings
7. Start Services
5. You’re done!

Master and Slave Configuration
Instructions

1. Install

Download and Install KeyShot Network
Rendering. Follow the prompts and click
Finish.

2. Select Mode

Upon installation KeyShot Network
Configurator wizard is automatically
launched. Select “Both master and slave
mode” and click Next (PC) or Continue (Mac).

3.  Select License Type

Select if you want to install a license file or
use a floating license by connecting to a
License Server.

3a. License file

If you have a license key, click
Request license and fill out the form.
Your network license should activate
automatically. Otherwise, click Save
license request, save the text file and
email it to license@luxion.com for
manual activation.
If you already have a license file (.lic),
click Select file, Browse to your license
file and click Open to select it.

3b. Floating License
Enter the hostname or IP Address of your
license server. If the server uses another
FlexLM port than the standard (27000) you
need to specify the port number, followed by
the “@” sign and the server’s hostname/IP
(e.g. 27000@KeyShotServer.local). Click
Connect.

3c. Once the license file is recognized, the
license text shows you how many cores the
slaves (combined) can use for Network
Rendering and when the license will expire.
Click click Next (PC) or Continue (Mac).

Learn more about Network Rendering
License.

4. Master Network Settings

Choose if you want to auto-detect
clients and slaves. When auto-detect is
enabled slaves/clients on the network
will automatically connect to the
master, otherwise you will need to
enter the master's IP and port

Note:
Please note that only one computer in your network should be configured as the master, if you need to
have multiple Masters click here.



mailto:license@luxion.com
https://luxion.atlassian.net/wiki/spaces/K72NR/pages/69870614/Slave+Settings
mailto:license@luxion.com
mailto:27000@KeyShotServer.local
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418578670/License
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/657915994/Multiple+Masters
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information in their respective
connection settings.
Select the ports for the master/client
connection and master/slave
connection. Leave the default values if
you are not sure.

Click Next (PC) or Continue (Mac).

5. Master Security Settings

If you want to be able to control who can
submit, delete, and download jobs etc. you
can enable User System. When enabled add
the username and password for the main
administrator, i.e. the owner or faclitator.
Users are added via the KeyShot Network
Monitor.

Allowing Anonymous users will let anyone on
the network submit jobs to Network
Rendering.

Click Next (PC) or Continue (Mac).

Learn more about User System & Security.

6. Slave Network Settings

Hostname & Port - Enter the
connection settings so they match
what was entered on the master.
Leave the Master host name empty if
the master has auto-detection enabled.
Process Priority -  This will set the
priority of the slave service in the
computer. This is relevant if you are
also running other applications on the
computer, in which case a low priority
will let the other applications use what
they need of the available CPU
resources first.
Allowed Cores - Here you can set the
default number of cores that are made
available for Network Rendering. If you
need to limit it temporarily, you can do
it via the Slave Tray - see how.

Click Finish (PC) or Done (Mac).

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727927/Users
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727937
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596880/How+To+Change+The+Number+Of+Cores


21

7. Start Services

When you have been through the wizard you
are ready to go. All you need to do is click
install and start on the Master and Slave in
the Service Status section of the Network
Configurator.

5. You’re done!

Click Close to close the configurator.

If you want to learn about setting up the master and slaves in the Network Configurator, go to the Master setup and the Slave Options sections.

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418283788/Master+setup
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/629342425/Slave+Options
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Client Configuration

So your master configuration is set up. The slaves are connected. What now?  Well, before you can send a job to
the network, you need to make sure that your computer can “talk” to the master via the queue-master connection.
This queue-master connection must be set up within KeyShot Network Monitor on the client’s side.

Client Configuration Instructions

1. Install

Download and Install KeyShot Network Rendering. Follow the prompts and click Finish.

2. Select Monitor Mode

The configuration wizard appears. Select Monitor only and click Finish (PC) or Done (Mac).

On this page

1. Install
2. Select Monitor Mode
3. Establish Connection
4. Render...

3. Establish Connection

The KeyShot Network Monitor will launch. By
default, the connection is set to auto-detect
and connect to the Master. 

You may also disable auto-detecting the
master and specify a Master hostname and
the correct Monitor port number, if you wish to
specify the Master.

Click Apply. KeyShot Network Monitor will
connect to your master.

You can always change your connection
settings under  File > Connection Settings.

4. Render...

You can now render over the network.

Note
If KeyShot Network Queue cannot connect to your master, then you may contact Luxion Customer
Support at support@luxion.com for further assistance.



https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418250898/Master+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418250927/Slave+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415891808/Render+Over+The+Network
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415891808/Render+Over+The+Network
mailto:support@luxion.com
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Render Over The Network

Once the client configuration is complete and KeyShot Network Monitor is able to connect to the master, you will
be able to send your render jobs to the network. In the instructions below we assume that KeyShot is installed on
your client computer.

How to send a job to the network
1. Open your scene in KeyShot.

2. Open the Render dialog - It can be launched from the toolbar , via the Main menu > Render > Render or the
hotkey Ctrl+P (Windows) or Cmd+P (Mac).

3. In the Options section select Send to Network.

4. Select the the rest of your render settings and confirm by clicking the Send to Network button.

KeyShot will sync with KeyShot Network Monitor. Your job will be transferred to the master computer and it will be
added to the network queue. Anyone successfully connected to KeyShot Network Monitor will be able to see the
list of jobs in the queue.

If you are unable to send jobs to the network, you can contact Luxion Customer Support
at support@luxion.com for further assistance.

On this page

How to send a job to the network

Tip:
You do not need to be connected to the network while the job is being rendered. The images will be stored
on the master. Next time you connect to the master, with the same user and computer, your finished jobs
will automatically be downloaded to the given location. If you log into the monitor on another computer you
can manually download your jobs. Learn more.



https://luxion.atlassian.net/wiki/display/K72NR/Client+Configuration
mailto:support@luxion.com
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596901/Jobs
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User Interface

Network Rendering has 3 applications where you can interact with the service: KeyShot Network Monitor, KeyShot Network Configurator and the KeyShot Network
Slave Tray. This section contains a brief user interface overview.

Network Monitor
Network Rendering Configurator
Slave Tray

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/416088413/Network+Monitor
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/421167311/Network+Rendering+Configurator
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/625213570/Slave+Tray
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Network Monitor

KeyShot Network Monitor allows you to interact with the network master, slaves, and jobs in the queue.

1. Delete

Delete your render jobs. Administrators may delete any job. For more information about user priviliges, click here.

2. Slave Status

Show/Hide Slave status panel (7).

3. Login account

Displays the logged in user’s name. For more information about logging in/out, click here.

4. Jobs tab bar

Select My Jobs or All from the sidebar area. You may also filter either of these by jobs that are In Progress or
Completed.

5. Render job queue

Lists all render jobs submitted to the network. For more information about handling jobs, click here.

6. Details about the selected job

Properties - Displays render job name, type of render, and owner. As well as a small thumbnail of what is
rendering/rendered.
Preview - Displays image rendering progress.
Log - Lists all events related to the job.

7. Slave Status Window

Shows connected slaves, available/allowed cores per slave, and the assigned regions. Possible status are shown
below:

Ready – the slave is connected and is ready to render.
Updating – currently updating software; not available for rendering.
Receiving – currently receiving job data for the task to render.
Rendering – currently rendering.

On this page:

1. Delete
2. Slave Status
3. Login account
4. Jobs tab bar
5. Render job queue
6. Details about the selected job
7. Slave Status Window
8. Slave Schedules
9. Request all current logs

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727927/Users
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/421167260
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596901/Jobs
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Sending Results – sending results back to the master.
Failed – if the slave fails 3 times it will be made inactive, waiting for an admin to take a look at the situation.

8. Slave Schedules

Show/Hide slave schedules toggle. Slave schedules determine when a slave is active or inactive. For more
information, click here.

9. Request all current logs

Download a ZIP file containing logs for all connected slaves.

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415662517/Slave+Schedules
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Network Rendering Configurator

 KeyShot Network Configurator allows you to configure your computer as a master, slave, and/or client.

General Settings

Here you can select the language for the Network Configurator, Monitor and the Slave Tray widget. 

You can also launch the Configuration wizard if you want to be guided through the setup and finally you can close
and launch the Monitor.

Service Status

Displays the configured services and their current status on your computer. To work properly, a service must be
Installed and Running.

Master

Here you can enable/disable Master service, enter license details and set up master service settings such as
Ports. For instructions on how to configure your computer as a master, click here.

Security

Displays security settings. For more information, click here.

Update Checking

Enable/disable automatic software update checking. For more information, click here.

Slave

Her you can enable/disable Slave service. Select the port, process priority and allowed cores. For instructions on
how to configure your computer as a slave, click here.

Resource Location

Displays the resource directory.

Master: on the Master the resource folder is where all jobs are stored.
Client: on the Client the resource folder is where Network Rendering archives jobs before they are sent to
the master.

 For more information, click here.

Logging

Enable/Disable service logging. ON by default. You can find all log text files at the designated location. For more
information, click here.

Email

Displays email notification settings.  For more information, click here.

On this page:

General Settings
Service Status
Master

Security
Update Checking

Slave
Resource Location
Logging
Email
Close And Restart Services
Run Configuration Wizard

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418283788/Master+Options
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/629342425/Slave+Options
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/625311945/Client+setup
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418283788/Master+Options
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727937
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415629549/Update+Checking
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/629342425/Slave+Options
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727922/Change+Resources+location
https://luxion.atlassian.net/wiki/display/K72NR/Logging
https://luxion.atlassian.net/wiki/display/K72NR/Email+Notifications
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Close And Restart Services

Close the Network Configurator, save your changes, and re-start your configured services (if any).

Run Configuration Wizard

Launches the configuration wizard.
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Slave Tray

When the slave service is running on your computer the Slave Tray widget can be found in the Task menu on
Windows or the Menu bar on Mac.

The Slave Tray widget gives you the option of pausing or limiting the amount of cores used for Network Rendering.
This is useful if you are making your work PC available as a slave, but still need to use it some of the time.

Set Cores

The overall amount of cores that are made available for the master is defined in the Network Rendering
Configuration, but you can override that setting here and limit how many cores that are available.

Slave Paused

Here you set the slave to paused, making it temporarily unavailable for the master.

Use all cores on sign out

When this is checked all cores will be available for the master while the user is signed out but the machine is still
running (not hibernated). The feature will be reset when the user logs in again.

On this page

Set Cores
Slave Paused
Use all cores on sign out
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Master Options

In this section, we’ll go over the master features. For a user interface overview, click here. Please note that these
features must be set inside KeyShot Network Configurator on your master.

License
Change Port Numbers
User System & Security
Update Checking
Change Resources location
Logs
Email Notifications
Multiple Masters

https://luxion.atlassian.net/wiki/display/K6M/Network+Rendering+Configurator+UI
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418578670/License
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418250956/Change+Port+Numbers
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727937
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415629549/Update+Checking
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727922/Change+Resources+location
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596918/Logs
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596924/Email+Notifications
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/657915994/Multiple+Masters
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License

You only need a license for the master, this limits the number of slave cores that can be used at any given time,
but it does not limit the number of users that can send jobs to Network Rendering.

There are 2 different types of licenses for Network Rendering

License File - the license file is located on the computer acting as master.
Floating License - the license is handled by a license server which the master connects to.

On this page

Using License File
Deactivating a license
Replacing The License File

Using Floating License
Replacing the Floating
License
Multiple Masters

Using License File
1. Launch KeyShot Network Configurator on
your master.

2. Go to the Master tab.

3. Select the License File option in the Master
License section

4. If you have a license key, click Request
license and fill out the form. Your network
license should activate automatically.
Otherwise, click Save license request, save
the text file and email it
to license@luxion.com for manual activation.

5. If you already have the license file, click
Select file, Browse to your license file and
click Open to select it.

6.  Your license file installed. The license text
shows you how many cores the slaves
(combined) can use for Network Rendering
and when the license will expire.

7. Click Close and restart services. Your
master service will re-launch.

Deactivating a license

In some cases you may need to move your
license to another computer. in such cases
you can click Deactivate license, move the .lic
file to the other computer and follow the steps
above to set up the license on the new
master.

Replacing The License File

If you have received a new license file from
us, you may easily replace the old license
and update your master service. Just follow
the steps above. Notice that if a user has
KeyShot Network Monitor is open, while
replacing the license file, it will briefly lose
connection to the master (the master needs
to re-start).  When prompted, check your
Monitor connection settings and click Apply.
The client-master connection will come back
up.

Using Floating License
(Windows and Mac only)

If you don't already use Luxion License
Server for your keyshot licenses you can
follow this guide to install the Luxion License
Server.

1. Launch KeyShot Network Configurator on
your master.

2. Go to the Master tab.

mailto:license@luxion.com
https://luxion.atlassian.net/wiki/spaces/K8M/pages/311984257/Luxion+License+Server+Installation
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3. Select the Floating License option in the
Master License section

4. Enter the hostname or IP Address of your
license server. If the server uses another
FlexLM port than the standard (27000) you
need to specify the port number, followed by
the “@” sign and the server’s hostname/IP
(e.g. 27000@KeyShotServer.local). Click
Connect.

5.  Your license had been installed. The
license text shows you how many cores the
slaves (combined) can use for Network
Rendering and when the license will expire.

6. Click Close and restart services. Your
master service will re-launch.

Replacing the Floating License

If you have received a new floating license
from us you need to replace it in the Luxion
License Server. There is no need for updating
it in the Network Rendering Configurator, as
the License Server will handle everything.

Multiple Masters

With the floating license you have the option
of having multiple masters on the network -
learn more here.

https://luxion.atlassian.net/wiki/spaces/K8M/pages/311984257/Luxion+License+Server+Installation
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/657915994/Multiple+Masters
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Change Port Numbers

KeyShot Network Rendering uses port number 4797 to connect monitor and master. The slave-master connection
uses port 4798. We recommend keeping default port values. However, you may change these ports within
KeyShot Network Configurator.

How To Change The Port Numbers
On the master

1. Launch KeyShot Network Configurator on your master and go to the Master tab.

2.  Enter the port numbers under Monitor Client port and Slave port.

3. Press Close and restart services. Your master has been re-configured. Proceed to your slave computers (step
3 below).

On the slaves

On this page:

How To Change The Port
Numbers
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4. Launch KeyShot Network Configurator on your slave machines and go to the Slave tab.

5. Change the value under Slave port.

6. Press “Close and Restart Services”.  Your slave service is will restart and it will connect to the new port. Proceed
to your client computers.

On the client computers

7.  Launch KeyShot Network Monitor on your client machines. If Connected, then you can stop here. Otherwise
proceed to step 8.

8.  Disable Auto detect master and fill in the master hostname (or IP Address) and the queue port.  In this example,
the Queue Client port is 4787.

7.  Click Apply.  KeyShot Network Monitor will connect to the master.

Technical Tip:  If the KeyShot Network Monitor application does not look similar to the above image or if you are
getting an error message, then you may contact Luxion Customer Support at support@luxion.com.

mailto:support@luxion.com
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User System & Security

Whether your company is big or small, security is important. KeyShot Network Rendering allows you to set an
administrator account, disable image previewing in the monitor, and configure SSL for increased protection of
communications, i.e., your creative assets. 

Please note that all security settings must be set inside KeyShot Network Configurator on your master.

User System
With User system you can set up user privileges for Network Rendering. In the Network Configurator on the
Master you can set up an administrator account. in the Monitor an administrator can manage jobs, manage user
privileges, and set the slave schedules. By managing users, the administrator controls who can submit, download,
and/or delete jobs.

Allowing anonymous users means that clients do not need to be signed in to the monitor, to be able so
monitor/handle their own jobs, these will be tied to the computer/host name.

If the user system is not enabled everyone connected to the network will have the same abilities as an
administrator. 

Disable Image Preview
KeyShot Network Monitor shows you a preview when you select a job in the list. Disabling the image
preview ensures that only those involved in asset creation know what the final output looks like.

SSL Settings
You may use SSL to secure communications between master and client systems.

How to set up SSL Settings

1. Launch the KeyShot Network Configurator and select Enable in the SSL settings under the Master, Security tab.

2. Browse to your private key and click Open.

3. Browse to your SSL certificate (.pem) and click Open.

4. Click Close and restart services.

On this page:

User System
Disable Image Preview
SSL Settings

How to set up SSL
Settings

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596901/Jobs
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727927/Users
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415662517/Slave+Schedules
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596901/Jobs
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Update Checking

While Update Checking is enabled, KeyShot Network Monitor will check online for software updates every time it is
launched or when you log on to your computer. This setting is enabled by default.

If KeyShot Network Monitor cannot retrieve software updates, you may configure your proxy server settings under
“Update server proxy”. 

Please note that update settings must be set inside KeyShot Network Configurator on your Master.

On this page

How to Enable Update Checking

How to Enable Update Checking
1. Enable Update system - When enabled
KeyShot Network Rendering will notify you
when an update is available.

2. Enable automatic update checks from
monitor instances - When enabled all
monitors will

3. Select proxy type, HTTP, or SOCKS v5.

4. Set the host and port. 8080 is the default
port.

5. You may enable proxy authentication.
Otherwise, skip to step 6.

6.  Click Close and restart services.
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Change Resources location

When you install KeyShot Network Rendering, a resources folder called KeyShot8NetworkResources is created.

The resources folder contains configuration settings, service logs, and, in the case of the master, all the render
jobs (completed and pending). This folder is typically found in your Public Documents (PC) or Application Support
(Mac).

Default location:

On Windows: C:\Users\Public\Public Documents\KeyShot8NetworkResources
On Mac: /Library/Application Support/KeyShot8NetworkResources

How To Change Your Resources Folder
1. Create a new resources folder at the desired location.
2. Launch KeyShot Network Configurator on your computer.
3. Go to the Resource Location tab, click Unlock (and confirm in the alert) to be able to edit the location.

4.  Click the browse button (…) to select the new resource folder.

5. Browse to the new folder and click Select Folder.

On this page

How To Change Your Resources
Folder
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6. Click Close and restart services and confirm to save the changes.
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Logs

The log files keep track of Network Rendering state, information, and potential errors. To enable logging, click on
“logging” in the KeyShot Network Configurator and check the “Enable logging” option.

Log Level
Choose at what level to record logs from:

Trace - shows all types of log messages
Information - no trace but shows warnings, errors, and fatals
Warning - no trace and information, but shows warnings, errors, and fatals
Critical - no trace, information, and warnings, but shows errors and fatals
Fatal - no trace, information, warnings, and errorrs, but shows fatals

Choosing a lower log level will record all other log levels below it.

Days To Keep Logs
Set a cutoff time for saved logs. Any logs that pass the set time frame will be deleted.

Log Location
By default, the logs will be stored in the Network Rendering resources folder in a folder called Logs. The log
location can be saved to a different location by selecting the browse button and selecting a new path, e.g., network
path etc. This will not change the resources folder for network rendering, only the logs. A log file will be generated
for a master service and slave service on the appropriate machine, in this location.

Logs can be accessed via the monitor. Click the Request all current logs button or right-click > Request current log
file the slave you want logs from.

On this page

Log Level
Days To Keep Logs
Log Location

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727922/Change+Resources+location
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Email Notifications

KeyShot Network Rendering can notify you, e.g. when your license is about to expire. To receive notifications, you
must enable email inside the KeyShot Network Configurator on the master.

How to Set Up Email Notifications

1. Go to the Email tab inside KeyShot Network Configurator and enable “SMTP settings”.

2. Set up the details for the outgoing mail that the master will use for notifications.

Fill in Host and Mail Client Port. You can find this information in your email client settings.
You can enable TLS/SSL or leave it unchecked. If you do enable it, make sure to use ports 465 or 587.
Enable Credentials and fill in your username and password for the outgoing mail.
Click Check settings. The Configurator will check your email settings and provide you with a confirmation
message.  
Please consult your IT for any troubleshooting when setting up SMTP.

3. Enter the General email address, this will receive all general notifications (see which below).

4. Click Close and restart services. Your master service will restart and the email feature will be activated.

Mail Notifications
Network Rendering will notify the general email when

the license is about to expire
the license is expired
a job fails

Users who have entered their email in the account settings (in the monitor) will receive an email when a job is
completed.

On this page

How to Set Up Email Notifications
Mail Notifications
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Multiple Masters

Generally having one master on the network is the way to go. This master will have access to all cores allowed by
the license, and all connections with slaves and clients can be established by auto-detection.

But in some cases you need to have multiple masters - maybe group A must not be able to see what group B is
working on and vice versa. In KeyShot Network Rendering 8.1, this can be done with a floating license where you
can have multiple masters sharing the number of cores allowed by your license.

Setting up multiple masters
When operating with multiple masters you follow the same setup procedure as you would normally do and just
refer to the same license server on all masters (Master Configuration). The only difference is that you can not use
Auto-Detect in the connection settings, but must set a fixed host in the connection settings for both slaves and
clients.

You can also enable the User system on each master so only registered users can access the Network Rendering
on that specific master.

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418578670/License
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418250898/Master+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/629342425/Slave+Options
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/625311945/Client+setup
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727937
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Slave Options

The   KeyShot Network Configurator allows to enable Slave Mode, set the Master hostname and Slave Port,
along with Process Priority and the Allowed Cores. You'll also find the option to launch the Slave Tray at login here.

Launch the Network Configurator on the computer where you want to set up/edit the slave settings and go to the
Slave section (you can also go through the wizard to set up - learn more)

Enable Slave Mode

If you want the computer to act as a slave, you must enable the slave mode. Once you have set up the slave, you
also have to make sure the slave service is installed and running in the Service Status section.

Master Hostname

Here you can specify which master the slave should connect to. If you leave the field blank the slave will auto-
detect the master on the network and automatically connect to it.

Slave Port

Here you can set the port for the slave-master connection. This should match the port set in the configuration of
the master - the default slave port in KeyShot 8.1 is 4798.

Process Priority

This will set the priority of the slave service in the computer, this is relevant if you are also running other
applications on the computer. In which case a low priority will let the other applications use what they need of the
available CPU resources first.

Allowed Cores

Here you can set the default number of cores that are made available for Network Rendering. If you need to limit it
temporarily, you can do it via the Slave Tray - see how.

Launch Slave Tray on user login

(Windows and Mac only)

By default, all computers working as Network Rendering slaves will have a the Slave Tray widget running. You can
find it in the Task menu on Windows and the menu bar on Mac. In cases where you do not want the users to be
able to easily limit/pause the cores you can disabled this.

In this section

Slave Schedules
How To Change The Number Of
Cores

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418250927/Slave+Configuration
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/418283788/Master+Options
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596880/How+To+Change+The+Number+Of+Cores
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/625213570/Slave+Tray
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415662517/Slave+Schedules
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596880/How+To+Change+The+Number+Of+Cores
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Slave Schedules

By default, a slave is active when connected to the master. The slave schedules inside KeyShot Network Monitor
offer control of when each slave will be active or inactive. Network administrators can setup the slave schedules
by logging into his/her account from any master, slave, or client computer. Learn more about users.

The slave schedules window shows a list of slave computers along with each individual slave’s weekly schedule.
 The schedule is made up of red and green blocks. Green means active, while red means inactive. An active slave
will use its processing power for rendering while an inactive slave will not use any of its processing power for
rendering.

On this page:

How To Set A Slave’s Schedule

How To Set A Slave’s Schedule
1. Log In
Inside KeyShot Network Monitor, click File >
Log in and enter your administrator
credentials.

2. Show Slave Status
If the slave status panel is not visible Click
Slave Status to display it.

3. Launch slave schedule manager
Inside the Slave Status panel, click Slave
Schedules.

4. Select Slave
Select the slave you want to set up a
schedule for in the top list. Now you can
either choose to use a preset schedule or
create your own.

5. Slave Schedule Presets
The slave schedule comes with two presets:

Always Active 
Non Work Hours - This will make the
slave inactive Monday to Friday,
between 8am and 5pm (8:00-17:00).

6. Custom Schedules
You can also create your own schedule
based on your rendering and processing
needs. For example, you may want a slave to
become active only at the end of the work
day. Click the 1-hour blocks to toggle
active/inactive.

7. Save your custom preset (optional)
Once you have set up your schedule, you can
click Save as preset to save a custom preset.

Name your preset and click OK.  You may
now select this preset from the Presets drop-
down (5).

8. Apply Schedule
Click Set Slave Schedule. Your slave

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727927/Users
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schedule is now set!
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How To Change The Number Of Cores

The slave service is by default set to use all of your processor cores. Thus, you may experience an overall system
slow down if you are running other applications on a slave while it is rendering. To lighten the load, you can
release some cores on your slave. This can be done in two ways:

1. by editing/limiting the default core number in the Network Rendering Configurator - see how
2. by temporarily overriding the default core number in the Slave Tray widget. Please note that the slave

service will revert to its default settings when you restart the computer.

Setting the core count in the Slave Tray
1. Log into your slave machine and find the Slave Tray widget, it is located in the taskbar on Windows and in the
menu bar on Mac.

2. Right-click the Slave Tray widget and select Set Cores.

3. Change the number of cores. The slave service will restart in the background. Once it restarts, the slave will
reconnect to the network.

Pausing the Slave Service from within the Slate Tray
1. Log into your slave machine and find the Slave Tray widget, it is located in the taskbar on Windows and in the
menu bar on Mac.

2. Click Pause Slave.

3. Select AbortTask when prompted.

On this page

Setting the core count in the
Slave Tray
Pausing the Slave Service from
within the Slate Tray

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/629342425/Slave+Options
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Client setup

Anyone on the network with KeyShot Network Rendering installed can connect to the master.

The Monitor lets you view the queue and, if you have the right user privileges, you can administer users, reorder
the jobs of the queue, and download and delete jobs. In order to submit jobs to Network Rendering you need to
have KeyShot installed.

Installation

Download and install Network Rendering from here. Upon installation the Network Rendering wizard is
automatically launched - Select only monitor. This will launch the Monitor.

Establish Connection

In the Monitor under  File > Connection Settings you must specify the connection method. By default, the
connection is set to Auto-Detect and connect to the Master. You may also disable auto-detecting the master and
enter a Master hostname and the correct Monitor port number.

Also see

Log In/Out
Handling Jobs
Managing Users
Clear Your Queue

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727927/Users
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596901/Jobs
https://www.keyshot.com/resources/downloads/
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/421167260
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596901/Jobs
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727927/Users
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415662508/Clear+Your+Queue
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Jobs

You may log into your user account inside KeyShot Network Monitor from any master, slave, or client
computer. Logging into your network account allows you to download and/or delete your completed jobs.

Users can be given additional privileges so they can download and/or delete all jobs, manage user privileges,
and edit the slave schedule.

1. Download a job

You do not need to be connected to the network while the job is being rendered. The images will be stored on the
master. Next time you connect to the master, with the same user and computer, your finished jobs will
automatically be downloaded to the given location. If you log into the monitor on another computer you can
manually download your jobs.

To download a job, simply right-click the job in the queue and select Download.

2. Delete a job

To delete a job, or a selection of jobs, select the job(s) in the queue and click the delete button or right-click the job
and select Delete.

3. Change priority on a job

To move a job up/down in the queue order, simply right-click the job and select Increase priority of Decrease
priority.

Note: If a change in priority moves a processing job down in the queue, the current tasks in process will be
finished, but no new tasks will be started on that job, until tasks from jobs with a higher priority are done.

4. Pause a job

You can also pause jobs that are processing. In this case the current tasks will be finished and the job won't be
resumed until it is unpaused. You find the pause/unpause options when you right-click a job.

On this page

1. Download a job
2. Delete a job
3. Change priority on a job
4. Pause a job

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727927/Users
https://luxion.atlassian.net/wiki/spaces/K72NR/pages/69868907/Users
https://luxion.atlassian.net/wiki/spaces/K72NR/pages/69868957/Slave+Schedules


49

Clear Your Queue

You can find an archive of all completed jobs on the computer acting as the master. We recommend that the queue
is cleared regularly as a large amount of jobs in the queue may impact performance.

Deleting a job via the Monitor will remove it completely from the master, so an administrator can clear the queue
directly from the Monitor.

Alternatively, you can delete the jobs via the resources folder on the master.

1. Access the computer acting as the Network Master.

2. Launch KeyShot Network Configurator and go to the Master tab. Then, click Stop to stop the Master service.

3. Open your file browser and browse to KeyShot Network Resources > Master.

Default location on Windows: C:\Users\Public\Public Documents\KeyShot8NetworkResources
Default location on Mac: /Library/Application Support/KeyShot8NetworkResources

4. Delete all sub folders under the Master folder. These are all the jobs in the queue (done and in-progress).

5. Go back to the KeyShot Network Configurator application and click Close and restart services.

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727922/Change+Resources+location
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Users

If User System has been enabled on the master, users can log into their accounts from any computer on the
network via the Network Rendering Monitor.

Network administrators may access the user management system, add or remove accounts, and change
privileges for each account. In the instructions below, we assume that you have set up administrator credentials on
your master.

How To Add/Remove Accounts
1. Log In
Launch KeyShot Network Monitor, click File > Log in and log in with your administrator credentials.

2. Open User Settings
In top right corner of the monitor you can now see that you are logged in. Click the triangle next to your username
and select User settings.

3. Add or remove user
Click the Add (+) button to add or Remove (-) to remove a selected account. Note: The main administrator, created
in the Network Rendering Configurator, can not be removed.

On this page

How To Add/Remove Accounts
How To Change Account
Privileges
User Privileges
Anonymous users

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727937
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4. Set up new user

When adding an account, fill in the appropriate information, assign privileges, and click Create User. The
respective user can log in using his/her credentials.

How To Change Account Privileges
1. Select the account and enable/disable privileges.

2.  Click Update User and close the user system dialog when finished.

User Privileges
Administrator - The user can do all of the things below.
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Create Jobs - The user can send jobs to Network Rendering.

Modify jobs by others - The user can change priority, pause, and delete jobs by others.

Download Jobs by others - The user can download all jobs.

Manage slave schedule - The user can set up/edit slave schedules.

Anonymous users
If Anonymous Users has been enabled in the User System & Security section of the Network Configurator on the
Master, you do not have to be logged in to be able to send jobs to Network Rendering. In this case, the computer
from where the job is submitted will be listed as the user. Jobs can only be deleted/downloaded from the computer
that submitted them, unless you are logged in with administrator privileges.

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415662517/Slave+Schedules
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727937
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Log In/Out

You can log into your user account via the KeyShot Network Monitor from any master, slave, or client computer. 

Logging into your network account allows you to download and/or delete your completed jobs. If you need to be
able to download/delete all jobs, manage user privileges, and edit slave schedules, these privileges can be added
to your account by an administrator - see how.

If you opt for not logging in, you are considered an anonymous user. An anonymous user may only download jobs
that he/she created as long as these jobs were sent from his/her current client computer.

How To Log In
1. Launch KeyShot Network Monitor and go to File, Log in.

2. Type your username and password. You may enable Log in automatically when Monitor is started to prevent
future prompts.

3.  Click Log In.  Your name will appear at the top right corner inside the KeyShot Network Monitor window.

On this page

How To Log In

https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415596901/Jobs
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727927/Users
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415662517/Slave+Schedules
https://luxion.atlassian.net/wiki/spaces/K8NR/pages/415727927/Users
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Similarly, you will find Log out in the File menu.
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Update Your Software Version

Master, Slaves, and Clients should all run the same version of KeyShot Network Rendering.

After an update, the Master will automatically update connected Slaves, but each Client will need to be updated
individually.

Update the Master and Slaves
If Update Checking is enabled, the update service in the monitor let you know when a new version is available. But
you can also check for updates via the Main menu > Help > Check for Updates.

1. Update the Master - on the computer acting as Master you can update KeyShot Network Rendering in one of
the following ways:

Download and install the latest KeyShot Network Rendering update from
https://www.keyshot.com/resources/downloads/ 
Launch the Network Rendering Monitor and Click Update in the update dialog.

2. Launch KeyShot Network Configurator on your Master.

3. Press Close and restart services. Your master will re-start and all existing slaves services will be automatically
updated.

Update Clients
Clients need to be connected to a Master in order to receive information about updates. As soon as your Client is
connected to a Master, the Monitor will check if your client is running the same version as the Master - if they are
not, you will be asked to update and given an update link.
As mentioned above you can also always download and install the latest version from
https://www.keyshot.com/resources/downloads/.

For help updating your network, you may contact Luxion Support at support@luxion.com

On this page

Update the Master and Slaves
Update Clients

https://www.keyshot.com/resources/downloads/
https://www.keyshot.com/resources/downloads/
mailto:support@luxion.com

